
SYQWEST INCORPORATED 
High Resolution Echo Sounders and Acoustic Systems 

For Precision Seafloor Exploration 

 
30 Kenney Drive 

Cranston, RI 02920 

TEL: (401) 432-7129 / FAX: (401) 432-7029 

tech-support@syqwestinc.com | http://www.syqwestinc.com/ 

 

AquaScan HD™  
Precision Side Scan Sonar System 
 

• Installation 

• Operation 

• Maintenance 

 
 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  Ver 2, 12.20.10 

 

 

 

 

mailto:tech-support@syqwestinc.com
http://www.syqwestinc.com/


 

 

 

 

 

 



 

TABLE OF CONTENTS I 

TABLE OF CONTENTS 

1.0 INTRODUCTION .............................................................................................................................. 1-1 

1.1 GENERAL INFORMATION ............................................................................................................ 1-1 
1.2 ABOUT THIS MANUAL ............................................................................................................... 1-1 
1.3 SIDE SCAN ACOUSTIC PRINCIPLES ............................................................................................. 1-2 

1.3.1 Underwater Acoustics ........................................................................................................ 1-2 
1.3.1.1 Decibels .......................................................................................................................... 1-2 
1.3.1.2 Sound Propagation ......................................................................................................... 1-2 

1.4 AQUASCAN HD™  SENSOR SPECIFICATIONS ............................................................................ 1-7 

2.0 INSTALLATION ............................................................................................................................... 2-1 

2.1 - AQUASCAN HD™ SYSTEM INSTALLATION OVERVIEW .......................................................... 2-1 
2.1.1 Setting a Static IP Address for Network Connection ......................................................... 2-1 
2.1.2 Setting an Alternate Static IP Address for Network Connection ....................................... 2-3 
2.1.3 -  Getting Started ................................................................................................................ 2-4 

2.2 TOWFISH ASSEMBLY (DIMENSIONS & MECHANICAL) ................................................ 2-5 
2.2.1 P/N P04610 AquaScan HD™  TowFish Assembly ............................................................ 2-5 
2.2.2 - Installing the AquaScan HD™ Electronics ..................................................................... 2-6 
2.2.3 – Installing/Deploying the AquaScan HD™ Towfish ........................................................ 2-8 
2.2.4 - Electrical Connections ................................................................................................... 2-12 

2.3 - AQUASCAN HD™ PC SOFTWARE INSTALLATION ................................................................. 2-15 

3.0 OPERATION ..................................................................................................................................... 3-1 

AQUASCAN HD™ PC SOFTWARE ......................................................................................................... 3-1 
3.1 - THE MAIN WINDOW ................................................................................................................. 3-1 
THE AQUASCAN HD™ MAIN INTERFACE IS DIVIDED INTO THREE FIELDS, THE CONTROLS FIELD, THE 

STATUS FIELD, AND THE DATA FIELD.  THE CONTROLS ARE LOCATED AT THE TOP OF THE MAIN 

WINDOW, THE DATA IS LOCATED IN THE CENTER, AND THE STATUS IS LOCATED ON THE BOTTOM ..... 3-1 
3.2 THE MENU BAR .......................................................................................................................... 3-3 

3.2.1 The File Menu .................................................................................................................... 3-3 
3.2.2 The Edit Menu .................................................................................................................... 3-4 

3.2.2.1 Configure Sonar Port ..................................................................................................... 3-4 
3.2.2.2 Configure NMEA I/O .................................................................................................... 3-5 
3.2.2.3 Configure Events............................................................................................................ 3-6 
3.2.2.4 Configure Thermal Printer ............................................................................................. 3-7 
3.2.2.5 User Preferences ............................................................................................................ 3-8 
In addition, both the Local Time and UTC Time zones can be synchronized to GPS Time provided 

that a GPS Receiver is connected to the AquaScan HD™ PC Software and configured correctly.  

(Refer to Configure NMEA I/O in Section 3.2.2.2 for more information) .................................... 3-9 
3.2.3 The Options Menu ............................................................................................................ 3-10 
3.2.4 The View Menu................................................................................................................. 3-11 
3.2.5 The Help Menu ................................................................................................................. 3-12 

3.3 THE TOOLBAR .......................................................................................................................... 3-12 
3.4 THE STATUS BAR ..................................................................................................................... 3-13 
3.5 AQUASCAN HD™ SYSTEM OPERATION .................................................................................. 3-14 

3.5.1 Deploy Towfish ................................................................................................................ 3-14 
3.5.2 Operate/Collect Survey Data ........................................................................................... 3-14 

3.5.2.1 Steering ........................................................................................................................ 3-14 
3.5.3 Recover Towfish ............................................................................................................... 3-14 

3.6 DATA OUTPUTS ........................................................................................................................ 3-14 
3.6.1 ODEC Depth (dpt) Format .............................................................................................. 3-14 
3.6.2 PMC Depth (dt) Format ................................................................................................... 3-15 
3.6.3 NMEA Depth Below Transducer (dbt) format ................................................................. 3-15 



TABLE OF CONTENTS 

TABLE OF CONTENTS II  

3.6.4 NMEA Depth (dpt) ........................................................................................................... 3-16 

4.0 MAINTENANCE ............................................................................................................................... 4-1 

4.1 – POST (POWER ON SELF TEST) ................................................................................................ 4-1 
4.2 – LED INDICATOR ...................................................................................................................... 4-1 
4.3 – FIRMWARE UPDATE ................................................................................................................ 4-1 

4.3.1 – Connection ...................................................................................................................... 4-2 
4.3.2 – Firmware Update File .................................................................................................... 4-2 
4.3.3 – AquaScan HD™ PC Software Firmware Update ........................................................... 4-2 

4.4 – TROUBLESHOOTING................................................................................................................. 4-3 
4.4.1 – AquaScan HD™ Sensor Troubleshooting....................................................................... 4-3 
4.4.2 – AquaScan HD™ PC Software Troubleshooting ............................................................. 4-3 

4.5 HOW TO PERFORM SOFTWARE AND FIRMWARE UPDATES ........................................................ 4-4 
 

TABLE OF FIGURES 
Figure 1-1 Absorption Coefficient Versus Frequency .......................................................................... 1-3 
Figure 1-2 Acoustic Beam Pattern .......................................................................................................... 1-6 
Figure 2-1 System Interconnect Diagram .............................................................................................. 2-4 
Figure 2-2 Bulkhead Mounting the Sensor Unit ................................................................................... 2-7 
Figure 2-3 Typical Over the Side Mount (reference drawing) .......................................................... 2-10 
Figure 2-4 Over The Side Transducer Mounting Picture .................................................................. 2-11 
Figure 2-5 AquaScan HD™  Sensor Unit Connections ...................................................................... 2-12 
Figure 2-6 AquaScan HD™  Sensor Power Connector ...................................................................... 2-13 
Figure 2-7 AquaScan HD™  Sensor Data Connector ......................................................................... 2-14 
Figure 2-8 AquaScan HD™  Sensor Transducer Connector ............................................................. 2-14 
Figure 2-9  Printer Port ......................................................................................................................... 2-15 

 

TABLE OF TABLES 

 
Table 2-1 Basic Equipment ..................................................................................................................... 2-4 
Table 2-2 Accessories and Options ......................................................................................................... 2-5 
Table 2-3 Portable Transducer Installation Parts .............................................................................. 2-10 
Table 2-4 AquaScan HD™  System Cables ......................................................................................... 2-12 
Table 3-1 Sound Velocity (Celcius versus part per thousand) ............................................................. 3-9 



AQUASCAN  

Operations and Maintenance Manual 

INTRODUCTION 1-1 

2018 SyQwest Incorporated 

1.0 INTRODUCTION 

1.1 General Information 

The AquaScan HD™ is a portable, low power, high-resolution, and water-resistant marine side scan 

imaging instrument capable of delivering high resolution acoustic imagery for a host of applications.  

When used with a customer supplied, Windows compatible Host PC the instrument provides a turnkey 

solution for seafloor imaging that is simple to use and easy to deploy.  It is designed exclusively for 

inshore and coastal marine surveys up to 300 meters at a 15-degree slant angle and operates at 200kHz.  

Included with the AquaScan HD™ product is the following: 

 

• AquaScan HD™ Sensor Unit  

• AquaScan HD™ Installation CD 

• AquaScan HD™ Manual 

• AquaScan HD™ Towfish 

AquaScan HD™ Sensor Unit provides all of the transmit/receive electronics, and the signal processing 

functions.  It is powered from a 10-30VDC source and consumes 10 watts of power. It interfaces to the 

Host PC via a single COM port.  The mechanical case for the Electronics Unit is Water Resistant to the 

EN60529 IP65 Specification and is also UV Stable and Chemical Resistant.  

The AquaScan HD™ Installation CD will install the PC software used to configure, control, and acquire 

data from the AquaScan HD™ Sensor device.  It will also include this manual in PDF format and any 

Release Notes that have been generated. 

A hardcopy of the AquaScan HD™ Manual is also included so that the user may learn to install, operate, 

and maintain the AquaScan HD™ Equipment and Accessories.  The manual also includes a section on 

acoustic theory as it pertains to the use of side scan systems. 

The AquaScan HD™ PC software was designed for use with the Windows operating systems.  We 

recommend the software be used on a PC with a processor speed of at least 1 GHz.  The software requires 

at least 1 available Ethernet Port for connection to the AquaScan HD™ instrument, and optionally, 

additional Serial Ports for NMEA Navigation/GPS Input, NMEA Depth Out, and External Annotation.  

The software features Navigation Input, External Annotation, Data Storage, Thermal Printer output, 

Automatic/Manual Eventing, and more.  The AquaScan HD™ software interface is divided into three 

distinct display areas.  The Controls area is located on the upper portion of the display.  Most of the user 

modified system parameters (Range, Gain, Record to disk, …) are located in this area.  The Data area is 

located in the middle of the display and shows all of the acoustic echo data in a waterfall type manner.  

The Status area is located along the bottom portion of the Display.  The system time, date, navigation 

position and speed, towfish altitude, and system state are all visible in this area.    

1.2 About This Manual 

This manual contains important information regarding acoustic theory, installation, operation, and 

maintenance of your new equipment.  The user should take sufficient time to read the entire manual and 

to understand the full functionality of the AquaScan HD™ Sensor and PC Software. 

The manual is organized into four chapters:  
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1) An introduction (this section), which provides a system overview and basic outline of side scan 

acoustics. 

 

2) Installation, which provides details on how to properly mount all of the AquaScan HD™ System 

components.  Details on installing the AquaScan HD™ PC Software package are included also. 

3) Operational instructions describing how to operate the AquaScan HD™ Sensor unit and the 

AquaScan HD™ PC Software. 

4) Maintenance, which provides information on replaceable parts and troubleshooting guidelines.   

 

The user should pay attention to notes that are displayed in a gray box.  These notes contain important 

information regarding installation and use of the AquaScan HD™ System.  An example is given below: 

 

NOTE: Important operation and installation information is provided in gray boxes 

throughout the manual. 

1.3 Side Scan Acoustic Principles 

Basic side scan acoustic principles that should be understood by all operators of acoustic imaging 

equipment are provided in this section.  

1.3.1 Underwater Acoustics 

1.3.1.1 Decibels 

The scale most often used to describe a measurement unit of sound is the decibel (abbreviated “dB”).  The 

decibel system was selected for a number of reasons.  First, it is a logarithmic system, which is useful for 

dealing with large changes in measured quantities.  Decibel units make multiplication and division simple 

because they are reduced to an addition and a subtraction operation respectively.  Secondly, for 

underwater acoustics, the primary concern is ratios of power levels and signal levels rather than absolute 

numeric values. 

Transducer calibration values are typically provided in units of decibels, including source level, receive 

sensitivity and directivity index.  These transducer calibration values are outlined later in this section.  

These quantities are used to predict performance levels of a given transducer used with a sonar system. 

1.3.1.2 Sound Propagation 

The sea, together with its boundaries, forms a remarkably complex medium for the propagation of sound.  

Figure 1-2 shows the interaction of a transmitted sound source and the water.  Both signal loss and 

interference result from interactions with boundaries and components within the water column, causing 

the source to be delayed, distorted, and weakened.  The main components affecting sound propagation are 

spreading loss and attenuation loss. 

Spreading Loss 

As a transmitted pulse of sound leaves the transducer, it spreads out in all directions.  At the transmission 

point, the sonar puts a fixed amount of energy into the water.  As the pulse travels away from the 

transducer, it occupies a greater and greater volume.   This effect is called spherical spreading.  The 

general rule is that the intensity of the sound falls off as the square of the distance traveled.  In respect to 

typical acoustic measurements, this mathematically becomes a loss of 6 decibels for each doubling of the 

distance. 
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For echo sounders, the distance actually traveled is two times the distance to the seafloor from the source 

transducer (from the transmission source, to the bottom and back again).  This results in a significant 

source of signal loss for the system receiving the sound pulse, which must be compensated for at the 

receiver.  Typically, a Time Varied Gain (TVG) amplifier is used to correct for spherical spreading loss in 

an acoustic receiver.  A TVG amplifier works by applying an increasing amount of gain to the return 

signal as time of travel increases. 

 

Attenuation Loss 

Attenuation of sound energy in the oceans comes from three factors: absorption, scattering (or 

reverberation) and bottom loss. Sound absorption takes place at two levels; one, absorption in the actual 

seawater medium, and two, absorption into the seafloor.  Primary causes of absorption are viscosity and 

thermal conductivity in the molecules of water as the sound travels.  At the molecular level, absorption is 

primarily related to frequency. At high frequencies- 500 kHz, for example, a loss of 0.14 dB/meter occurs 

in seawater, while at 50 kHz the loss is only 0.014 dB/meter.  This is a major concern when selecting a 

transducer required to meet specified depth criteria.  A graph showing the attenuation loss versus 

frequency is shown in Figure 1-1. 

 

Figure 1-1 Absorption Coefficient Versus Frequency 
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Sound reflected off the seafloor usually suffers a significant loss in intensity.  Part of this loss is due to 

scattering (reflection) but most of it results from the portion of sound entering the new medium and 

traveling into the seafloor until it is completely absorbed.  The amount of energy lost by this effect varies 

greatly and depends on bottom type, sound frequency, and the angle at which the sound intersects the 

seafloor.  Total losses can vary from 10 dB to 40 dB, with hard bottoms (packed sand, rock outcrops) 

causing little loss, and soft bottoms causing a significant amount of energy loss (muddy, silt-like 

sediments).  Therefore, it is necessary when designing an echo sounder to compensate for this wide range 

in signal variation. Another form of attenuation is scattering, also called reverberation, which results 

when sound reflects off components in the water column.  Some of these reflectors include boundaries 

(sea surface and bottom), bubbles, biological material, suspended particulate, and water type boundaries 

such as thermoclines.  As the sound pulse travels from the transducer, it will reflect off these objects in 

many different directions.  The larger the area of the reflector compared to the wavelength of the 

transmitted sound, the more effective it is as a scatterer.  During the scattering process, part of the sound 

is reflected back to the surface, and the rest is scattered in all directions.  This will cause a reduction in the 

acoustic energy that can travel to the seafloor and back to the transducer.  For echosounding, this causes a 

reduced signal strength, which complicates location of the bottom.  In the extreme case, scatterers will 

cause such a good reflection it looks like the bottom to the echo sounder and corrections must be made by 

the user to properly determine the digitized bottom value. Bottom reverberation occurs whenever a sound 

pulse strikes the ocean bottom.  In deep water this condition normally does not cause serious problem, but 

in shallow water reverberation can happen multiple times, causing high background signal levels (i.e. the 

sound travels from the surface to the bottom and back again many times). 

Noise Sources 

Background noise can cause interference with the reception of the desired acoustic echo return from the 

seafloor.  Unlike reverberation, however, noise does not result from the transmitted pulse but from active 

producers of noise located at the ship or in the water.  Noise can be classified as self produced or ambient 

noise.  

Self-noise 

Self-noise is produced by noisy ship components, electrical circuitry, and water turbulence around the 

transducer, including noise caused by water flow and cavitation. Machinery noise and other sonar systems 

are the main components of ship produced self-noise.  The dominant source of machinery noise is the ship 

power plant, including the main engine, generators, and propellers.  The only way to reduce the effect of 

these noise makers is in proper selection of the transducer frequency for the echo sounder, and to locate 

the transducer as far away as possible from the noise sources.  Typically, these sources are of lower 

frequencies than the echo sounder, but some mechanical and electrical equipment will produce sound in 

the ultrasonic region (above 15 kHz) which can detrimentally affect the performance of a system. In 

general, echosounding, flow noise, cavitation, and sonar circuitry are more important than other noise 

sources.  Flow noise results when there is a difference in the relative motion between the transducer and 

water surrounding it.  As flow increases, friction between an object and water increases, resulting in 

increased turbulence and, thus, increasing noise due to varying static pressure in the water.  Flow noise is 

directly related to the speed of the ship and, on an improperly mounted transducer, there is usually a 

certain speed threshold that will cause the echo sounder to start picking up unwanted noise.  Increased 

flow noise over time can usually be attributed to growth of marine animals and plants on the bottom of 

the ship. 
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Cavitation is a result of the pressure on the face of the transducer reducing to a level that permits the 

water to boil (i.e. turn from a liquid to a gas).  This is directly related to the flow around the transducer as 

described above.  Cavitation is also related to the depth, source level, and frequency of the transducer 

being used.   As the depth of the transducer increases, static pressure increases to levels that will prevent 

cavitation from occurring.  If the transducer is mounted properly, with flow noise and cavitation levels 

considered, this phenomenon should never affect an echo sounder. Cavitation may also occur on a ship’s 

propeller.  As the speed of the water increases over the surface of the propeller, turbulence causes changes 

in the static pressure of the water.  At this point, if the pressure is low enough, boiling will occur.  This 

process releases a large quantity of bubbles into the water, causing noise that can affect the performance 

of an echo sounder.  Care should be taken to mount a transducer as far as possible from this noise source.  

Ambient Noise 

Ambient noise is always present in the ocean.  This noise is caused by both natural or human-made 

events.   For echosounding principles, ambient noise sources that are significant include hydrodynamic 

boundaries, ocean traffic and biological transmitters. Hydrodynamic noise results from natural 

phenomenon such as wind, waves, rain, or currents.  The levels produced vary greatly but are largely 

related to the sea state level.  In severe storms, hydrodynamic noise can reach levels that make reception 

of a transmitted signal very difficult, if not impossible. Ocean traffic noise is dependent on the number of 

ships, the distance from noise sources, and the current propagation conditions due to thermoclines and sea 

state.  Ocean traffic generally produces acoustic noise that is not within the frequency bandwidth of most 

navigational echo sounders, except when ships pass very near to the receiving transducer. Biological 

noise producers include marine life such as shrimp, fish, and mammals.  Mechanical movements of 

crustaceans, with their hard shells, may produce significant noise when in large schools.  Likewise, 

certain fish species produce noise by reflecting noise off their swim bladder. 

Transducer Properties 

Properties of a chosen transducer affect sonar performance which directly relates to depth measurements.  

The source level, directivity index, and beam width of a transducer have a relationship with how the sonar 

system performs under different conditions. 

Source Level 

Sound is created by a transducer from a mechanical vibration of the ceramic material of which underwater 

transducers are made.  The movement of the transducer face creates alternating regions of high and low 

pressure, resulting in an acoustic wave.  The amount of energy transmitted into the water column is 

defined as the acoustic source level.  A source level is expressed in units of decibels that describe the 

intensity of sound relative to a reference intensity at one unit distance from the sound source.  For the 

user, a source level is useful for selecting a transducer for a particular use. The amount of movement on 

the face of the transducer is linearly related to the voltage difference created across the ceramics of the 

transducer.  Normally it would seem desirable to put as much power into the water as possible to achieve 

maximum depth performance.  Cavitation, however, which results from high source levels and small 

transducer depths below the sea surface, is generally the limiting factor when driving a transducer.  The 

electrical and mechanical design of the transducer, which has a maximum recommended input power 

level, must also be considered. 
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Beam Width  

The beam width of a transducer is described as the width of the main lobe of a transmit pattern.  The 

width is usually measured between the -3 dB points on either side of the beam pattern.  Shown in Figure 

1-2 is a transmit beam pattern for a 125 kHz transducer.  The shape of the transducer beam pattern is a 

result of the transducer design.  An array of ceramic elements, or a single ceramic element, emits sound at 

given frequency.  The spacing of the elements and the frequency being used can control the shape of the 

beam pattern.  At the center of the beam pattern is the main lobe of the transducer, with a width of 7 

degrees (centered at zero degrees).  The -3 dB point is shown as a dashed line on the graph.  The side 

lobes of this transducer are the smaller lobes, approximately 18 dB below the level of the main lobe. 

 

Figure 1-2 Acoustic Beam Pattern 

 

The width of a beam is important for calculating how small an object the system can detect.  If two 

objects fall within the main beam the object will appear as one object when it is received by the system.  

Thus, a narrow beam width is required for navigational echo sounders, so it can discriminate small 

objects. 

The size of the transducer sidelobes (smaller beams off to the side of the main lobe) is important in 

determining how the system will behave on steep slopes.  On steep slopes, transmitted acoustic energy 

from the side lobes will be received first and reveal a signal that looks like the actual bottom.  In reality, 

the bottom is directly below the ship, and as seen by the main lobe, is much deeper.  For this reason, it is 

important to select a transducer which has reduced sidelobes.  

Directivity Index 

The directivity index measures the ability of a transducer to reject noise from extraneous sources.  In the 

ocean, noise may be coming from all directions, but a narrow beam transducer will only “hear” noise 

within the beam width pattern.   A sonar system signal to noise ratio (SNR) will be affected by the ability 

of a transducer to reject unwanted noise, and thus is related to the directivity index.  The higher the 

directivity index of a transducer, the better the ability to reject unwanted noise. 
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1.4 AquaScan HD™ Sensor Specifications 

 

Units Feet or Meters 

Slant Ranges 
 60, 120, 240, 450, 750, 900Feet. 

20, 40, 80, 150, 200, 250, 300Meters. 

Max Horizontal  

Resolution: 

<1cm; Slant Range dependent 

Pulse Lengths:  Pulse Lengths: 5,10,25,50,200,400,800 (microseconds) 

Beam Width: 1 degree x 30 degrees 

Depression Angle:  15 degrees 

Output Power: Output Power: 600 Watts (pulsed); (1000watt capable) 

Geographic Position 
NMEA 0183, GLL, GGA, RMC, VTG, VHW, HDT 

Selectable Baud Rates (RS-232):  4800, 9600, 19200, 38400 

Printer Output Interface to TDU Series Thermal Printers 

Transmit Rate Up to 10 Hz, depth and operator mode dependent 

Event Marks Periodic, External, and/or Manual (Periodic selectable in 1-minute intervals) 

Data File Output 
Industry Standard XTF,  

SyQwest ODC format (Proprietary)   

Data File Playback 
Files can be played back and/or printed at Normal or Fast-Forward speed, with Pause and 

a Playback Scroll Bar for ease of file playback. 

Frequency Output 200Khz 

Display 
Normal Data, Navigation, Depth, Command/Status, Color Control for Data: 4 Selections 

or Custom (User Input), Data Color Invert possible 

Sound Velocity 4600 - 5250 ft/sec (1400 - 1600 mt/sec) 1 mt/sec int. 

Serial Data Output NMEA 0183, DPT, DBT, PMC, Hypack & HydroPro Compatible 

Data Interface SYQWEST AquaScan HD™ Interface, Ethernet Port 

Shallow Water 

Operation 
< 5 meters; application dependent 

Input Power 10-30 Volts DC, Nominal power 8 Watts,  

Reverse Polarity and Over Voltage Protected 

Dimensions Sensor Unit: 188mm (9.95" ) Width, 217.6mm (11.0") Height,and 62.2mm (2.45") Depth. 

Tow Fish: 124cm (49" ) Length, 32.4cm (12.76") Max Width 

Weight: 
Sensor: 9kg (2 lbs). (sensor unit only) 

Tow Fish: 12.7kg (28 lbs). (tow fish and cable) 

Environmental 

0°C to 50°C Operating Temperature (0°C to +95°C Storage) 

Water Resistant to EN60529 IP65 

EMC meets EN60945 Emissions; CE Compliant 

Specifications subject to change without notice. 
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2.0 INSTALLATION 

2.1 - AquaScan HD™ System Installation Overview 

This section presents instructions for initial setup and installation of the AquaScan HD™ Sensor. Physical 

and electrical installation details are provided for connecting, mounting, and getting started with the 

AquaScan HD™. A summary is given of the software installation and setup procedure as well.  

Although the AquaScan HD™ Sensor is designed to deliver the highest levels of quality and 

performance, it can best attain those standards when the equipment has been properly installed. Because 

of the great variety of vessels that will employ the AquaScan HD™ Sensor, it is not feasible to provide 

complete and detailed instructions that will fit all installation possibilities. Therefore, this section will 

provide practical guidelines to assist the user in planning a typical installation of the AquaScan HD™ 

System aboard the vessel.  

Shown in Figure 2-1 is a system-interconnecting diagram. Optional items are shown with dashed lines. A 

minimum operational system configuration requires:  

 

1. PC running Windows 7-10, moderate capability laptop or desktop 

2. AquaScan HD™ Sensor Unit 

3. AquaScan HD™ Tow Fish Assembly 

4. AquaScan HD™ Cables (Power, Data, Transducer) 

5. 10-30 Volt DC Power Source (10 Watts) 

 

The GPS, NMEA Depth Out, and External Eventing connections are optional but, if used, will require the 

PC to have COM ports. The AquaScan HD™ Data I/O is compatible with both the Hypack & HydroPro 

Survey Software packages. For many portable PC’s additional COM ports may be installed via one of the 

PCMCIA expansion slots. 

The TDU Printer, if used, is attached via the PC’s Printer Port. 

2.1.1 Setting a Static IP Address for Network Connection 

 
To set up your computer, follow these steps.  

Go to: Start Settings Network Connections  

 

 

Right click on the “Local Area Connection” icon and 

select “Properties”  

You should see the following screen:  
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Scroll to and Click on “Internet Protocol” and then on 

“Properties”  

You should see the “Internet Protocol (TCP/IP) 

Properties” window.  

Click on the “Alternate Configuration” Tab  

 

You can either set up the interface under the “General” 

setup or the “Alternate Configuration” tab. 

If you have 2 or more Network connections available, 

you may want to use the “General” settings on your 

selected Network card. Click the “Use the following IP 

address” radio button and set it up with the IP address 

shown below (same as the alternate). If you already use 

that connection, or you are limited on your network 

connections, you can select the alternate tab. When 

selected it will be displayed with “Automatic private IP 

address” selected.         

 
 

Click the “Use the following IP address” radio button  

Enter the IP address information shown below  

Select “OK”  

For use with the AquaScan HD, it is required that you use the 192.168.199.113 address.  

 
 

If you have only one network connection, and 

you move the network cable from your 

standard network connection to the AquaScan 

HD when collecting data, you may prefer to 

set up the “alternate configuration” as shown 

on next page.  

 

This will preserve your “main” network 

settings, and default to these only when 

plugged into the AquaScan HD. 
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2.1.2 Setting an Alternate Static IP Address for Network Connection  

If you move your computer from being connected from a LAN using DHCP to your AquaScan HD or 

other equipment that uses a static IP address, you can set your computer up to automatically switch to the 

“alternate” static IP address.   

The use of the alternate IP address occurs when the computer cannot find a DHCP server such as when it 

is connected to your AquaScan HD.  

 

 
 

 

END OF SOFTWARE INSTALLATION 
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Figure 2-1 System Interconnect Diagram 

2.1.3 -  Getting Started 

Unpacking and Inspection 

Use care when unpacking the unit from the shipping carton to prevent damage to the contents. It is also 

recommended that the carton and the interior packing material be saved even after the unit has been 

installed on the vessel. In the unlikely event that it is necessary to return the unit to the factory, the 

original carton and packing material should be used. Verify that all parts described in the next section 

have been shipped with the unit. 

Basic Equipment  

The following (Table 2-1) is a list of the basic equipment supplied with the AquaScan HD™ Side Scan 

Sonar system. 

AquaScan HD™ System P04600-X  

Part Number Item Quantity    

P04603-1 AquaScan HD™ Sensor 

Unit  

1    

P04610-1 AquaScan HD™ Towfish 

Assembly 

1    

P04412 Power Cable (10 feet) 1    

C00210 Data Cable (10 feet) 1    

P04621 AquaScan HD™ Software 

CD 

1    

P04625 AquaScan HD™ Manual 1    

P04634-1 Case, Rail Pack 1* option    

Table 2-1 Basic Equipment 
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Accessories and Options  

The following items are available to complement and enhance the operation of the AquaScan HD™ 

echosounder. Please contact your authorized SyQwest distributor or visit our web site for information and 

assistance in obtaining any of these items. 

 

Product 

Code 
Item Quantity 

P02553 TDU-850 Thermal Printer 1 

P03050 12 Channel DGPS System w/ Combo Antenna 1 

P04634 Rail Pack, Shipping/Carrying Case 1 

Table 2-2 Accessories and Options 

 

2.2 TOWFISH ASSEMBLY (DIMENSIONS & MECHANICAL) 

(Tow Fish Assembly drawings and specifications are for reference only and are subject to change; please 

contact SYQWEST for current transducer information.) For installation suggestions, please visit our 

website http://www.syqwestinc.com/ 

 

2.2.1 P/N P04610 AquaScan HD™  TowFish Assembly 

 
 

Resonant Frequency:  200 KHz. 

Nominal Impedance:  150 ohms 

Beamwidth (@ 3 dB point): 1   X 30 

Cable:    50 meters (with plug) 

Housing Material:   PVC 

Stem    Stainless Steel ½-14NPS Thread 

Weight:    20 lbs (9 kg) 

http://www.syqwestinc.com/
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2.2.2 - Installing the AquaScan HD™ Electronics  

Instructions are provided in this section regarding the physical installation of the AquaScan HD™ Sensor 

Unit and the PC that is used for the User Interface. Guidelines are provided for locating and/or mounting 

the AquaScan HD™ Sensor unit and the PC. The installer should refer to Section 2.2.4 for information on 

electrical hookup.  

Selecting a Location for the Electronics  

The AquaScan HD™ Sensor Unit is designed for portable, marine applications but maybe used in 

permanent installations as well.  The user must determine if the AquaScan HD™ Sensor Unit is to be 

mounted on the vessel or just placed in a convenient place on-board the vessel.  Either way the 

appropriate location for the unit needs to be determined.  The following considerations should be 

investigated before deciding upon a location: 

1. User Supplied Personal Computer 

The first step in the equipment location process is to determine the optimum place for viewing the data.  

The unit should be positioned to provide the optimum viewing angle and within easy reach of the operator 

whenever possible. This will vary depending on the size of the vessel and type of Personal Computer 

(Desktop or Laptop) but is most important to insure the comfort and success of the user.  The location 

selection should consider that standard PC displays are not easily readable in direct sunlight.  Adequate 

space for the computer and any peripherals that need to be connected should be considered as well.  

Finally, provisions need to be made to properly secure the equipment for the worst sea conditions that 

may be encountered. 

2.  Cable Lengths. 

Both the Data Interface Cable and the DC Power Cable supplied with the product are 10 feet long.  Thus, 

the Sensor Unit must be installed within 10 feet of both the user supplied Personal Computer and a 10-

30VDC Power Source. The unit must also provide adequate access for cabling termination without 

binding and allow suitable space for servicing the equipment.  (If necessary, the data cable may be 

extended beyond 10 feet.  See Section 2.2.4 for more information) 

3.  Water Resistance. 

The Sensor Unit has passed the EN60529 IP65 Water Resistance Standard which ensures that the unit is 

completely sealed and is Splash Proof.  The unit should NOT however be installed in an area where the 

unit may be submerged in water. 

4.  Environmental. 

The operating temperature of the AquaScan HD™ Sensor is –25C to +60C thus the operating temperature 

range of the PC is likely the limiting factor for temperature.  The unit has also passed all of the EN60945 

emission tests (radiation and immunity).  For optimum system performance it is still recommended that 

the installer mount or place the Sensor unit in an area that is at least several feet away from any other 

electronic equipment or machinery on the vessel.  The unit should also be mounted or placed in an area 

that won’t be exposed to water if practical. 
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Mounting the Sensor Unit 

 This section outlines the steps for mounting the Sensor Unit.  Refer to Figure 2-2 while installing.  The 

unit may be mounted either horizontally or vertically.  The keyhole slots make installation in hard to 

reach areas easier but be sure to tighten all mounting hardware securely.  Insure that adequate room is left 

for installing and removing the cable connections.  Also, verify that the status indicator (labeled STAT) is 

visible.   

 

Step 1) Confirm that the area behind the intended-mounting surface on the bulkhead is clear of 

equipment, panels, electrical cables, conduits, hydraulic, air, water lines or pipes.  

 

Step 2) Using the Sensor Unit as a template mark a drill point for each of the mounting holes.  Insure that 

the marks for the keyholes are placed in the smaller, slotted areas.  

 

Step 3) Drill three (3) holes that will work with the mounting hardware that has been selected (not 

supplied).  The 3 holes on the Electronic unit are 0.195 inches in size (#8 size Screw 

recommended for installation).  

 

 

Figure 2-2 Bulkhead Mounting the Sensor Unit 
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2.2.3 – Installing/Deploying the AquaScan HD™ Towfish 

  

General Tow Fish Assembly  

The AquaScan HD™ is offered with lightweight Tow Fish Assembly that is equipped with a dual array of 

200KHz side scan transducers.  The Tow Fish is designed for portable, cabled towed or over-the-side 

mount applications.  Before using the Tow Fish Assembly, the system operator should read and 

understand the appropriate section below to ensure that all of the installation issues are considered. 

Deploying the Towfish Assembly 

 

Checking the Towfish Assembly Balance 

The initial deployment of the Towfish assembly shall be done from the rear of the vessel.  The operator 

shall first ensure that the entire length of the Towfish cable is available and free from any knots, kinks, or 

any issues that may cause a problem with cable pay out.  

With the vessel in neutral, the operator shall launch the Towfish over the side and hold the cable such that 

the Towfish is visible at a meter or so below the surface.  The Towfish shall appear suspended in the 

water in a horizontal position.  Performing this balance check verifies that the Towfish weighting and the 

Towfish cable interface is optimized for the side scan survey.  The Towfish assembly is weighted and 

balanced at the SyQwest facility for use in most survey conditions but the weighting can be changed by 

the user as required in shallow water applications.   

Flying the Towfish Assembly 

After the balance check is complete, the vessel shall proceed forward at a slow speed while the operator 

pays out the Towfish cable.  The standard AquaScan HD™ system is equipped with 50 meters of cable so 

up to 50 meters can be paid out by the operator.   The amount of cable that needs to be deployed depends 

on several factors that need to be addressed before the survey begins.  The survey depth range, vessel tow 

speed, ocean sea state, and other factors can all influence how much cable is deployed. 

The general rule for flying the Towfish is to keep the Towfish altitude (height above the sea floor) about 

5% to 10% of the selected Range during the survey.  This ensures that the Towfish shall remain clear of 

any obstacles and provides the longest effective range for a given set of seafloor conditions.  The image 

shadows will be smaller which is a consideration but, in most cases, the general rule provides the 

optimum survey data. 

Note that in shallow water and certain other sea state conditions it may be necessary to fly the Towfish at 

a deeper depth to minimize the acoustic and/or wave action near the surface.  Under these conditions, 

more Towfish cable may need to be paid out and slower vessel speeds may be necessary to obtain 

optimum side scan acoustic images.  The actual Towfish depth and altitude can be determined by viewing 

the acoustic waterfall display, however, at typical side scan survey speeds (2-6 knots) the Towfish cable 

pay out to Towfish depth ratio is usually about 3 to 1 (i.e. 30 meters of cable out = 10 meter of Towfish 

Depth). 
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Retrieving the Towfish Assembly 

Once the survey is complete, the Towfish shall be recovered by slowing the vessel to a speed that make 

the resistance on the Towfish and cable reasonable (2-3 knots).  The Towfish cable shall then be retrieved 

and recoiled in a manner that will make it easy to store and reuse.  When the Towfish is close to the 

vessel and in view the vessel can be placed in neutral so the Towfish can be properly stowed for the trip 

to shore.  The Towfish is rugged and built for use in fairly harsh environment but it should always be 

properly stowed before the vessel is run at high speeds.  The fins and the transducer assemblies are 

susceptible to damage if the Towfish is dropped or hit with a sharp or dense object.   

Towfish Care 

The Towfish is made of a PVC plastic material with Stainless Steel hardware.  The Towfish assembly 

should be cleaned with fresh water after every use to minimize any effects of corrosion and keep the 

exterior finish smooth.  The Towfish should also be kept out of direct sunlight for extended periods of 

time.  The carrying case is a good place to keep the Towfish assembly whenever it is NOT in use. 

Also, when handling the Towfish, avoid lifting or pulling the Towfish by the cable (except when 

deploying the Towfish into the water).  Although the cable is rugged and meant to be used for towing in 

the water, the internal cable wiring could be damaged by stress if the Towfish or cable is pulled in an 

awkward direction (not inline as it is towed during normal use). 

Cable Paths 

The cable path from the Electronics to the Towfish should be routed as far as possible from other 

electrical cables.  Although the cable is shielded, the acoustic reply from the transducer can be on the 

order of microvolts, thus any cable crosstalk emissions can cause a decrease in acoustic sensitivity.  

Handling the Side Scan Transducers 

The two side scan transducers within the Towfish are the heart of the AquaScan HD™ system and, in 

spite of its appearance and size, are delicate instruments.  Although they are designed to be in contact 

with and survive tough marine environments, they should not be dropped or mishandled during system 

use.  Caution is advised when handling the Towfish which house the transducers to prevent any damage 

to the transducer face or radiating surface. 

The transducers should always be as clean and smooth as possible, so the path of the sounding energy is 

uninterrupted.  The transducer face must not be painted with lead-based bottom paint.  Special care 

regarding the face of the transducers should be taken when cleaning the Towfish with fresh water after 

use. 

 

WARNING: Do not expose the transducer to any solvents when cleaning any excess 

sealants.  Strong solvents may damage the face of the transducer. 
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Over the Side Mount Installation 

Some portable installations of the AquaScan HD™ Towfish for some shallow water surveys vessels will 

be of the over-the-side pipe mount type.  Over the Side mount use of the AquaScan HD™ system is 

limited by the amount of wave action as the roll, pitch, and heave of the vessel will distort the acoustic 

images.  The type of installation can only be practical in areas where there is little to no wave action.  

This type of installation is achieved with the following list of materials: 

 

Part Number Item Quantity 

* AquaScan HD™   Transducer w/connector 1 

Optional AquaScan HD™ Over the Side Mount (OTSM) Assembly  

(or can be user supplied pipe mount described below) 

1 Kit 

User Supplied Silicone grease or petroleum jelly (Vaseline®) 1 

User Supplied Pipe coupling to attach to transducer 1 

User Supplied 
Pipe with threads to match the pipe coupling and length to give 

proper transducer depth 
1 

User Supplied Pipe coupling adapter 1 

User Supplied Support Lines or cables (fore/aft) 2 

User Supplied Pipe Clamps to affix the Pipe to the 4x4 1 (or 2) 

User Supplied Pressure Treated 4x4x (Ship’s Beam Width + 2 feet) 1 

User Supplied Large “C” Clamps to affix the 4x4 across the beam of the vessel 2 

User Supplied Protective Pads or Carpet Remnants 2 

User Supplied Mild Household Detergent (i.e., dishwashing liquid) 1 

 Table 2-3 Portable Transducer Installation Parts 

 

 

Figure 2-3 Typical Over the Side Mount (reference drawing) 

 

Refer to Figure 2-3 above while reading and implementing the Installation procedure listed below. 
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Figure 2-4 Over The Side Transducer Mounting Picture 

 

CAUTION:  Never pull, carry, or hold the transducer by the cable as this may sever 

internal connections. 

 

Installation Procedure: 

 
1.   Apply silicone grease or petroleum jelly to the threads of the pipe to facilitate later disassembly. 

2.   Twist the pipe coupling onto the pipe. 

3.   Push the transducer cable through the pipe. Alternately after the transducer is attached, clamp the 

cable to the outside of the pipe using cable clamps. 

4.   Apply silicone grease or petroleum jelly to the transducer stem.  Insure that the grease does not smear 

the face of the transducer. 

5.   Attach 2 lines or cables to the Transducer Mounting Assembly.  These lines or cables will support the 

pipe from the force of the water when the boat is underway. 

6.   Attach the Pipe Clamp(s) near the end of the 4x4 insuring that there is enough clearance for the 

transducer to hang over the side of the vessel. 

7.   Place the 4x4 across the beam of the vessel near the stern and fasten it to the gunnels with the C 

Clamps.  Use the Protective Pads or Carpet Remnants to protect the gunnels of the vessel.  Insure that 

the 2 foot extra length of the 4x4 extends beyond the beam of the vessel on the appropriate side and 

that the Pipe Clamp(s) attached to the 4x4 are on the extra length as well. 

8.   Attach the Transducer/Pipe Assembly to the 4x4 using the Pipe Clamps.  Insure that the transducer is 

deep enough into the water that sea conditions will not cause the transducer to get to the surface. 

9.   Fasten the line(s) or cable(s) fore and aft with sufficient tension to support the pipe when the boat is 

underway. 

10. Route the cable to the instrument being careful not to tear the cable jacket.  To reduce electrical 

interference, separate the transducer cable from other electrical wiring.  Coil any excess cable and 

secure it in a place with zip-ties to prevent damage. 

 

Over The Side Transducer Mounting 
(Example mount shown as reference 

only) 
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2.2.4 - Electrical Connections 

 

WARNING: Be sure to turn the vessel power off at the main switchboard before 

proceeding with the installation.  If power is left on or turned on during the 

installation, then fire, electrical shock or other serious injury may occur. 

There are 3 connections that need to be made to the AquaScan HD™ Sensor Unit and the PC for the 

system function properly.  The user also has the option of connecting a GPS input and/or a Thermal 

Printer.  The sections below describe the connection details for each. 

All electrical connections to the AquaScan HD™ Sensor unit are to the side of the unit.  Refer to the 

sections on each individual connector for information on connector type, recommended cable and wiring 

specifics.  Figure 2-1 at the beginning of the chapter shows the overall systems interconnect for the 

system.  

 
 

 Figure 2-5 AquaScan HD™ Sensor Unit Connections 

Figure 2-5 shows the basic connections to the unit.  In all installations, all of the connections must be 

made for the unit to function.  As shown above, there is a status indicator (STAT) and there are 3 

connectors from left to right: DC Power (3 pins), Data Interface (RJ-45), and the Transducer (10 Pins). A 

grounding screw, located to the right of the Transducer connector, is provided to connect the AquaScan 

HD™ to the vessel’s earth ground system.   The cables supplied with the AquaScan HD™ are ready to 

plug into the AquaScan HD™ Sensor Unit.  No user wiring is necessary.  The cables associated with the 

AquaScan HD™ Sensor Unit are listed below (Table 2-4).  The user should make sure that, after wiring is 

complete, each plug is firmly attached to the unit via the twist-lock mechanism. 

 

Part Number Item Quantity 

P04412 DC Power Cable (10 feet) 1 

C00210 Data Interface Cable (10 feet) 1 

   

 

 Table 2-4 AquaScan HD™ System Cables 
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DC Power Connection 

Before installing the power connection to the unit, the installer must first insure that the DC power source 

is in the range of 10-30VDC and is capable of providing 8 watts of power to the unit.  Although the 

AquaScan HD™ Sensor unit is reverse polarity and over-voltage protected, it is always required that the 

power mains be turned off during system wiring for both personal and equipment safety. 

The Power Cable supplied with the system is 10 feet long and includes 3 conductors.  The wires in the 

power cable must be connected as follows: 

 

RED  – Positive DC Voltage (Fused Lead), DC IN+ 

BLACK  – Negative DC Return, DC IN- 

WHITE  (GREEN) – Earth Ground, SHLD 

The DC Voltage lead includes a 3 Amp in-line Fuse.  In the unlikely event that the fuse is blown it should 

be replaced with a fuse of the same amperage.  Installing an incorrect fuse can result in damage or fire to 

the unit if it is not operating properly. 

The Power Connector on the Sensor Unit is shown below in Figure 2-6. 

 

 

 Figure 2-6 AquaScan HD™ Sensor Power Connector 

 

Electrical wiring standards require that the AquaScan HD™ Sensor Unit be properly attached to a solid 

chassis ground via the ground stud on the bottom of the unit, or the Earth Ground wire (WHITE or 

GREEN) in the power cable.  When connecting to the ground stud, a tinned copper braided wire (0.190 

gauge or greater) is recommended. 

 

NOTE: Connecting the Earth Ground is required for optimum system performance and 

safe operation.  The white wire in the power cable OR (BUT NOT BOTH) a ground 

wire to the unit ground stud is needed.  Connecting both the white wire and the 

ground stud to earth ground may degrade performance due to induced ground 

loops. 
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Data Interface Connection 

The Data Interface cable supplied with the AquaScan HD is 10 feet long.  If the 10 foot length of cable is 

not enough, the Data Interface Cable may be extended by using a standard Ethernet CAT-5 cable.   

 

 Figure 2-7 AquaScan HD™ Sensor Data Connector 

Transducer Connection 

The AquaScan HD™ transducer connector is typically hardwired direct to the transducer. 

The standard cable is 30 meters in length and has the 10 pin connector that mates to the Transducer 

connector on the AquaScan HD™ Sensor Unit.  5 of the pins on the 10-pin connector are wired to the 

unit.  They are defined as: 

 

WHITE (BLUE) - Transducer + 

BLACK  - Transducer – 

GREEN  - Transducer Shield 

 

The Transducer Connector on the Sensor Unit is shown below in Figure 2-8. 

 

 Figure 2-8 AquaScan HD™ Sensor Transducer Connector 
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GPS Connection 

Connecting a GPS or other Navigation input to the PC running the AquaScan HD™  software allows 

the user to store and annotate Date, Time, Position, and Heading information to the Acoustic data returns. 

The AquaScan HD™ PC Software supports the NMEA 0183 protocol on a COM port that is software 

selectable by the user.  When selecting a PC to use with the AquaScan HD™ system the user should 

insure that PC hardware supports 2 COM Ports if a Navigation input is desired (the AquaScan HD™ 

Sensor/PC interface requires 1 COM port). For Portable PC’s, a PCMCIA COM port card can often be 

used to provide a 2nd COM port. 

The user should refer to the GPS NMEA 0183 output connection information in their GPS Manual as well 

as the PC COM port wiring information in their PC Manual to ensure that the Navigation input is wired 

correctly. 

The AquaScan HD™ can also interface to a GPS using a UDP interface via IP 127.0.0.0 using port 

number 4543. 

Printer Connection 

The AquaScan HD™ PC Software allows the user to interface to the all of the SYQWEST TDU Thermal 

Printers.   The connection is established through the PC’s Parallel Printer Port (25-pin D-Type) as shown 

below in Figure 2-9.  Once the software has been started, all displayed acoustic data can be printed to the 

TDU in either Acquisition or Playback mode. 

 

 

 

Figure 2-9  Printer Port 

 

The standard TDU Printer cable is provided with the printer and is 12 feet long and does not require any 

user wiring.  Installers must locate the printer accordingly. 

 

2.3 - AquaScan HD™ PC Software Installation 

This section describes how to install the AquaScan HD™ PC software package.  It is assumed that the 

reader has a working knowledge of installing Windows XP, 7, 8, 10 software.  The installation software 

is located on the CD-ROM disc included with your AquaScan HD™. 

 

NOTE: It is recommended that you exit all running applications before inserting the CD 

and beginning the installation. 

To install the PC software, insert the AquaScan HD™ CD into an available drive.  If Auto Insert 

Notification is enabled on the CD-ROM drive, then the AquaScan HD™ PC installer will begin 

automatically.  If the CD does not auto-start, simply execute the SETUP.EXE file in the root directory 

of the CD. 

Once the installer is running, it will verify that your operating system is compatible with the AquaScan 

HD™ software, and then it will check which version of the Windows Installer program is installed in 
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your system.  If the Windows Installer program is not found or out of date, it will update it and prompt 

you to restart your computer.  Once restarted, the AquaScan HD™ installation will continue 

automatically. 

The InstallShield Wizard will guide you through the next step where you have the option of choosing an 

install directory.  By default, the AquaScan HD™ PC software is installed in the Program Files folder 

under the sub-directory ODEC or SyQwest. 

In the next step, you may choose a Typical, Minimal, or Custom installation.  Selecting Typical will 

perform a complete install of both the AquaScan HD™ application and Sample Data for playback.  A 

Minimal installation will only install the AquaScan HD™ application.  Additionally, you can choose 

Custom to manually select what you would like installed.  Click the next button to continue to the next 

step. 

The rest of the installation process consists of verifying your settings and clicking the install button.  

Also, once the installation is complete, you can check the Launch the program box to execute the 

AquaScan HD™ software as soon as you close the installer.  If not, you can run the AquaScan HD™ PC 

software by using the Windows Start button to find the AquaScan HD™ menu under Programs, or 

simply double-click on the AquaScan HD™ icon located on your Desktop. 

 

END OF SECTION TWO 
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3.0 OPERATION 

AquaScan HD™ PC Software 

This section describes how to operate the AquaScan HD™ Sensor using the PC Software package 

included with your AquaScan HD™. 

3.1  - The Main Window 

 

The AquaScan HD™ Main interface is divided into three fields, the Controls field, the Status 

field, and the Data field.  The Controls are located at the top of the main window, the Data is 

located in the center, and the Status is located on the bottom 

The Controls field is located in the top portion of the window.  It provides access to all of the user-

controlled parameters.   

The Data field is located in the center of the screen with the Port side acquisition on the left and the 

starboard on the right. 

The Status field is located on the bottom and contains the ping rate, date and time of recording, longitude 

and latitude, speed in knots, navigational direction, bottom depth and AquaScan HD™ sensor status. 
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NOTE: The current on-screen bottom image in both windows will be lost upon resizing the 

window 

 

1.) The Menu Bar (explained section3.2) 

2.) The Tool Bar (explained section 3.3) 

3.) Port Side Data Window 

4.) Starboard side Data Window 

5.) Color Palette 

6.) Status Bar (explained section 3.4) 
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3.2 The Menu Bar 

The AquaScan HD™ PC Software has 5 menus on the menu bar including File, Edit, Options, View, 

and Help.  Most of the AquaScan HD™ Software Preferences and Navigation configuration are 

accomplished through these menus. 

3.2.1 The File Menu 

 

Start Recording 

Creates a new file on the specified hard disk for capturing acquisition data.  If the AquaScan HD™ 

Sensor is already pinging, then the software will start the data recording immediately.  The filename is 

based on the date/time in the following format: 

<path>YYYYMMDDhhmmss.xtf 

 

<path> - This represents the path to a directory where the recorded files should be stored.  Refer 

   to User Preferences in this section for information on manually setting the path. 

YYYY - 4-digit Year 

MM - 2-digit Month 

DD - 2-digits Days 

hh - 2-digits for Hours 

mm - 2-digits for Minutes 

ss - 2-digits for Seconds 

.xtf - XTF’s  Proprietary File Extension 

 

NOTE:  Once recording is started, this option will become “Stop Recording”. 

 

Open for Playback 

Opens a previously recorded file for reviewing.  All other Playback functions are controlled by the 

coinciding buttons in the toolbar.  Playback filenames are created based on the date/time.  (Refer to the 

above section for more information) 

Recent Files 

The AquaScan HD™ software keeps a list of the 4 most recently opened playback filenames for easy 

access.  These filenames are found between the “Open for Playback” and “Exit” menu options.  Clicking 

one will immediately begin playback of the file. 

Exit 

You can exit the AquaScan HD™   PC Software by either using the “Exit” on this file menu, or by simply 

clicking on the windows default close button 
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3.2.2 The Edit Menu 

 
Insert Event Mark 

Selecting this option will generate and insert a formatted event mark on the display, in the recorded file (if 

recording is on), and if enabled, the thermal printout.  The event mark contents can be configured by 

selecting “Configure Events…” under the File menu.  In addition, an event mark can also be inserted by 

clicking the corresponding toolbar button.  

 

 Insert Annotation 

Selecting this option will allow you to enter a custom text message to be inserted on the display, the 

recorded file (if recording is on), and if enabled, the thermal printout.  In addition, annotation text can also 

be inserted by clicking the corresponding toolbar button.  

3.2.2.1 Configure Sonar Port 

 
 

 

Configure Sonar Port 

This menu allows you to enable/disable communication to the sensor by toggling the “Enable Serial IO” 

check box. It also allows you to input the Towfish Layback in either feet or meters. 
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3.2.2.2 Configure NMEA I/O 

 

This menu allows the user to configure the AquaScan HD™ software to receive NMEA 0183 

navigational information from a GPS receiver, or equivalent.  The user may also use this menu to select 

an output format for digital depth.  Both the GPS NMEA 0183 and NMEA Depth Out functions operate 

on the one COM port chosen by the user or through UDP.  An adapter from SYQWEST may be required 

to use both functions simultaneously.  Using the “Enable Serial IO” checkbox, you can enable/disable 

NMEA Input/Output.  When enabled, you can choose the appropriate PC COM port and communication 

parameters. 

Most GPS units are setup to use 8 Data bits, No Parity, 1 Stop bit, and either 4800 or 9600 Baud.  In 

addition, you must choose which NMEA format the software will use to collect navigational data.  Make 

sure you choose a format compatible with your GPS receiver.  Check your GPS manual for more 

information. 
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The “Synchronize System Time to GPS Time” option is provided as a means to synchronize the internal 

PC clock to the UTC Date/Time from the GPS.  The RMC Sentence is the only one which includes GPS 

Date and Time and so this option is only available when the RMC Sentence is selected for “NMEA 

Position”.  It will be disabled otherwise.    

NOTE:  Since Navigation Data Input and Digital Depth Output both use the same COM 

Port, both devices must use the same communication parameters, such as Baud 

Rate, Data Bits, Parity, and Stop Bits. 

 

3.2.2.3 Configure Events  

 

This menu is used to configure eventing and annotation.  Events may be generated by using the toolbar 

button, or the corresponding menu option “Insert Event Mark” under the Edit menu.  An event is a 

horizontal marker which appears on both the screen and printer.  A number of real-time parameters may 

be included with the events as derived by the user.  These parameters are shown in the previous picture 

under “Annotate Event Mark With...”.  In addition, the user may choose between 3 Eventing trigger 

methods including, Manual, Periodic, or External.  When in “Manual Eventing”, event marks are inserted 

only when one is requested by the user using one of the methods described above.  “Periodic Eventing” 

allows the AquaScan HD™ software to insert events at a specific interval, depending on the number of 

minutes entered by the user.  While in periodic mode, the user may still insert manual event marks in 

addition to the periodic ones.  “External Eventing” has been implemented as means of allowing third 

party software, such as HyPack, to remotely generate Event marks and annotation in the AquaScan HD™ 

software.  It can be configured by enabling the “External Eventing” option and setting the communication 

parameters such as COM Port, Baud Rate, Start Bits, Stop Bits, and Parity to match the configuration of 
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the third-party software. The AquaScan HD™ software accepts external annotation/eventing with the 

following format: 

(CTRL F) (CTRL A) (Annotation String) (CTRL D) - Generates an event mark containing 

the text in the Annotation String 

(CTRL F) -  Generates an empty event/fix mark  

 

NOTE:  External Eventing requires an additional free COM Port.  If there are no more 

available COM Ports on your PC, contact SYQWEST for an expansion card. 

 

NOTE:  Periodic Eventing is not available when External Eventing has been enabled. 

 

NOTE:  All event marks and text annotation shown on the screen are inserted BETWEEN 

the acquired bottom data so that there is no loss of information. 

3.2.2.4 Configure Thermal Printer 

 

This menu allows you to configure a thermal printer for use with the AquaScan HD™  software.  It 

supports 3 different models from the Raytheon/SYQWEST TDU series, including the TDU-850, TDU-

1200, and the TDU-2000, all TDU models are available from SyQwest Inc. 

In addition to Enabling or Disabling the printer, there are a number of other options available to the user.  

These settings only affect the thermal printout, not the on-screen display.  They include: 

• Display Negative Image 

- Enabling this option will invert the gray scale colors on the thermal printout. 

 

• Flip Rasters Left to Right or Top to Bottom 
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- Enabling this option will print a mirror image of the event/annotation marks.  This 

option is to be used in conjunction with the L/R dip switch located on the back of the 

TDU Printer (Refer to your TDU Manual for more information).  By default, the switch 

is set to the L position and so this option should not be enabled.  However, if the dip 

switch is set to R, enable this option to print the event/annotation marks correctly. 

• Print Grid Lines and Range Markers 

- Enabling this option will print the data along with 4 grid lines and periodic range 

markers. 

• Print Annotation Text Transparently 

- By default, this option is not enabled, and annotation is printed with a solid background 

so that the text is always readable. This will cause some bottom data not to be shown 

on the printout but will still be present on the display and recording file (if recording is 

on). Enabling this option will print annotation text without a solid background.  This 

may make annotation text hard to read when printed over bottom data.   

• Repeat Raster Count 

- A Repeat Raster Count can be entered between 1 and 10.  The default count is 1 Raster.  

Increasing this value will cause the printout to be stretched horizontally.  This option is 

useful when using a TDU-1200 or TDU-2000 printer which has a finer vertical 

resolution. (i.e. Pixels are small)  

 

 

3.2.2.5 User Preferences 

 

 This menu allows you to configure recording and playback options.  By selecting “Playback files 

continuously”, the current playback file will repeat from the beginning when it reaches the end.  The 

AquaScan HD™ software stores recorded data files in the same directory as the application by default, 

however, you can select an alternate location by clicking the “Browse” button and specifying another 

directory.   
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Additionally, you can limit the maximum recorded file size by enabling the “Automatic File Size” option.  

If the recording file reaches the specified size, it will create additional files to save the remaining data.  

This option is useful if your data will be transferred to removable media where space is limited. 

 The “Time Display” control allows the user to specify which Time Zone the Date/Time should be 

based on.  The Date/Time shown on the display will also be the value recorded to a file if recording is 

active.  Choosing “Local Time” will enable whichever Time Zone is currently selected in the Windows 

operating system.  (Refer to your Windows User Guide for more information regarding Time Zones).  

Selecting “UTC Time” will display Date/Time information based on the GMT Time Zone. 

 

 In addition, both the Local Time and UTC Time zones can be synchronized to GPS 

Time provided that a GPS Receiver is connected to the AquaScan HD™ PC Software 

and configured correctly.  (Refer to Configure NMEA I/O in Section 3.2.2.2 for more 

information) 

 

Sound Velocity  

The User Preferences Menu brings up the Preferences Window shown above. Sound Velocity is a 

critical parameter when performing surveying work.  The Preferences >Sound Velocity Selection 

allows the user to enter a calibrated Sound Velocity into the system for calculating an accurate 

depth measurement.  A Sound Velocity of 1400 - 1600 meters/second or 4595 to 5250 

feet/second can be selected (depending on current unit selection). 

 

Sound Velocity Calculations 

The user may determine the sound velocity applicable to a specific survey using three methods: 

A) Obtaining the measured sound velocity value from an external sound velocimeter. 

B) Performing a “BAR-CHECK” using the AquaScan HD™ Survey Echo sounder. To accomplish 

such, a plate (bar) is placed at a known depth below the transducer face. The user then varies the 

sound velocity value until the exact depth is displayed in the DEPTH field on the display (and, 

the chart). At that point of agreement, the entered sound velocity value will be correct for the 

specific survey area and time. In effect, the AquaScan HD™ contains an integral sound 

Velocimeter. 

C) Estimating the sound velocity by considering the salinity and temperature of the given survey 

area. The table below provides a matrix of sound velocity values for various combinations of 

salinity and temperature. 

Table 3-1 Sound Velocity (Celcius versus part per thousand) 

SAL 0 

ppt. 
5  

ppt. 
10 

ppt. 
15 

ppt. 
20 

ppt. 
25 

ppt. 
30 

ppt. 
35 

ppt. 
40 

ppt. TEMP 

0 deg. C 1400 1407 1414 1421 1481 1435 1442 1449 1445 

5 deg. C 1424 1431 1437 1444 1451 1457 1464 1470 1447 

10 deg. C 1445 1452 1458 1464 1471 1477 1483 1490 1496 

15 deg. C 1464 1470 1476 1482 1488 1495 1501 1507 1513 

20 deg. C 1481 1487 1493 1498 1504 1510 1516 1521 1527 

25 deg. C 1496 1502 1507 1513 1518 1523 1529 1534 11540 

30 deg. C 1510 1515 1520 1525 1530 1535 1540 1546 1551 

35 deg. C 1522 1526 1531 1536 1541 1546 1551 1555 1560 

40 deg. C 1532 1537 1541 1546 1551 1555 1560 1564 1569 
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(Sound Velocity values are in meters per second) 

 

3.2.3 The Options Menu 

 

 

  Units 

 Allows the users to select the range units in feet or meters. 

  Color 

 Invert Color Palette-(F3)- This option inverts the colors that the data acquisition window is currently 

using. 

 Toggle Palette-(F4)- This option switches the current color palette between the defaults and the user 

made custom palette. 

 Custom Colors- A window appears after selecting this option allowing the user to create a custom 

color palette for the data acquisition. 

  Sonar 

 Allows the user to choose between Data size 400 and 800. 

  Testing 
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3.2.4 The View Menu 

 

   View port and starboard-Both data windows collect and show the data 

   View Port side only- Only the data from the port side is collected and shown 

   View Starboard only- Only the starboard data is collected and shown 

 

  View Navigation – When selected the navigational compass will appear in between the data 

windows below the color palette. 

  Diagnostic View 

Selecting this option will allow you to view the current sensor status, which helps when doing system 

diagnostics with customer support 
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3.2.5 The Help Menu 

 
 

  

This menu includes an electronic copy of this manual along with an About AquaScan HD™ option.  

Clicking it will display a window with information such as the AquaScan HD™ software version and 

SYQWEST company information.  In addition, the software will request and display Hardware/Firmware 

version information from the AquaScan HD™ Sensor providing the Sensor is connected and 

communicating properly. 

 

 

 

 

 

 

 

 

 

3.3 The Toolbar 

 
 

 

1.) Start/Stop Pinging 

2.) Open Playback File  

3.) Insert Event Mark 

4.) Insert Annotation 

5.) Toggle View Window (Dual/Port/Starboard) 

6.) Play Data File (Playback Mode Only) 

7.) Fast Forward Data File (Playback Mode Only) 

8.) Pause Data File (Playback Mode Only) 

9.) Stop Data File (Playback Mode Only) 

10.) dB Gain Adjustor- When selected Arrows will appear to allow user to select desired level to 

close the arrow box click in the box not and not on the arrows. 

11.) Range Adjustor-  To adjust the range click on the box and select desired range 

 

 

 



AQUASCAN  

Operations and Maintenance Manual 

OPERATION 3-13 

2018 SyQwest Incorporated 

3.4 The Status Bar 

 

 

 1.) Ping Counter 

 2.) Date/Time 

 3.) Latitude 

 4.) Longitude 

 5.) Speed in Knots  

 6.) navigation in Degrees- If clicked the navigation compass will appear in the data fields 

 7.) Depth 

 8.) Sensor Status 

This indicator shows the current state of the AquaScan HD™ Sensor.  There are a total of 

5 different states: 

 

Unknown  - No communication is present between the Sensor and PC Software. 

Power On - Power has been applied to the AquaScan HD™ and the Sensor has begun  

  communicating. 

Initializing - The AquaScan HD™ software is handshaking with the Sensor to establish a 

reliable 

  connection. 

Idle - A connection between the PC and the AquaScan HD™ Sensor has been 

established,  

  but no commands have been received yet. 

Pinging  - The AquaScan HD™ Sensor is transmitting and receiving real-time bottom 

data. 

Playback  - The PC Software is displaying previously recorded data from a playback file. 
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3.5 AquaScan HD™ System Operation 

This Section describes how to properly deploy, collect data, and recover the towfish in the survey 

environment. 

 

3.5.1 Deploy Towfish 

1.) When launching the towfish the vessel should be traveling at a low speed  

2.) Launch the towfish from the stern of the vessel 

3.) DO NOT ALLOW the Cable attached to the towfish any slack during deployment or 

operation 

4.) It is recommended to use gloves when handling the cable  

 

 

3.5.2 Operate/Collect Survey Data 

1.) Do not allow the towfish to hit the bottom 

2.) Operating the towfish on a straight course will produce the clearest image possible 

3.) The lower the speed of the vessel will allow more pings on to hit each individual area  

3.5.2.1 Steering  

The manner in which the vessel is directed will affect the images captured by the sonar.  The 

towfish can only collect good images while it is pulled straight. 

1.) When turning the helmsman should use slow and small wheel movements 

2.) The helmsman has to inform the operator of the towfish before turning and cannot turn sharply, a 

sharp turn could cause the towfish to strike the bottom. 

 

 

3.5.3 Recover Towfish 

1.) When recovering the towfish the vessel should be slowed while the cable is being recovered, the 

vessel should still maintain enough speed to not allow any slack in the cable. 

2.) After the towfish is brought above the surface of the water it should be rinsed with fresh water 

3.) The transducer should also be shielded from direct sunlight. 

 

 

 

3.6 Data Outputs 

This section lists the various data output formats available from the Data I/O at the AquaScan HD™.  

This section provides more detailed, information for each format (sentence) to allow the user to interface 

with external peripheral devices Hardware pin-out connections are shown in Figure 2-7 

3.6.1 ODEC Depth (dpt) Format 

 Sample data strings 

$SDODC,00:00:00,N33.43.7300,W118.15.7300,B,0.0,M,V 

$SDODC,11:18:00,N33.43.9400,W118.15.9400,B,20.4,F,A 

 

This data output string is ODEC’s comma delimited proprietary format containing Time and Position 

(from a GPS device), true depth, and depth status.  This format is depicted below: 
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 $ S D O D C , h h : m m : s s , a y y . y y . y y y y , o x x . x x . x x x x , f , x x x x . x , u , v 

<CR><LF> 

Where h h = UTC Hours        m m = UTC Minutes      s s = UTC Seconds 

 a = N / S Latitude             y y . y y . y y y y = Latitude Degrees, Minutes, Decimal Minutes 

 o = W / E Longitude         x x . x x . x x x x = Longitude Degrees, Minutes, Decimal Minutes 

f = Depth Frequency (A = Low Frequency or Only Frequency, B = High Frequency) 

x x x x . x = True Depth     u = Units (M = Meters, F = Feet)    v = Depth Status (A = Valid, V = Invalid) 

3.6.2 PMC Depth (dt) Format 

Sample data strings 

FDT L 11.1 FT  EDT H 0.0 FT   DT H 21.0 FT   DT L 11.1 FT 

Proprietary depth output string. Format described below. 

 Single Frequency Operation   Dual Frequency Operation 

_D T_ _ x x x x . x _FT <CR><LF>  _D T_f _ x x x x . x _FT <CR><LF> (English mode) 

_D T_ _ x x x . x x _MT <CR><LF>  _D T_f _ x x x . x x _MT <CR><LF> (Metric mode) 

During normal operation the "space" in front of the "D" will be blank; An "E" in this space indicates an 

error such as lost bottom while an "F" indicates a Fix Mark.  The second character after the “T”, 

represented above by an f, indicates which frequency return the depth value applies to.  “H” indicates a 

High frequency depth, and “L” indicates a Low frequency depth. 

3.6.3 NMEA Depth Below Transducer (dbt) format  

Sample data strings 

$SDDBT,   11.1,f,   3.4,M,   1.9,F    $SDDBT,   21.0,f,   6.4,M,   3.5,F 

Industry standard NMEA 0183 string. Water depth referenced to the transducer. Format described below. 

 $ S D D B T , x x x x . x , f , x x x . x x, M , x x x . x , F  <CR><LF> 

Where  x x x x . x  = feet (f)               x x x . x x  = meters (M)                 x x x . x  = fathoms (F) 
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3.6.4 NMEA Depth (dpt) 

Sample data strings 

$SDDPT,    3.4,  0.0 $SDDPT,    6.4,  0.0 $SDDPT,    6.4,  0.2 

 

Industry standard NMEA 0183 string. Water depth relative to the transducer and offset of the measuring 

transducer.  

Format described below. 
 

 $ S D D P T , x x x x . x, y y . y   <CR><LF> 

Where  x x x x . x = Depth from transducer in meters    y y . y  = Offset from transducer, meters 

 

 

 

 

 

END OF SECTION THREE 
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4.0 MAINTENANCE 

4.1 – POST (Power on Self Test) 

 

Each time power is applied to the AquaScan HD™ Sensor, it performs a series of self-tests to ensure that 

it is working optimally.   The tests occur as follows: 

 

Test 1 – Initialization Test 

   Checks overall functionality of the sensor hardware to verify it is operational. 

 

 Test 2 – RAM Test 

   Verifies that the system RAM is operational. 

 

 Test 3 – Serial EPROM Test 

Verifies that the Serial EPROM is operational, and its checksum is valid. 

 

 Test 4 – Flash Memory Test 

Verifies that the Flash Memory is working and its checksum is valid. 

 

If Test 1, 2, or 3 fail, the Sensor’s green LED will blink rapidly at 4 Hz indicating an error.  The 

AquaScan HD™ Sensor will not be operational and the user should contact SYQWEST’s Support Dept. 

for assistance.  If the Sensor fails Test 4, the green LED will blink normally at 1 Hz, but will not function 

until it is reprogrammed.  The AquaScan HD™ PC Software will detect this problem and notify the user.  

(Refer to Troubleshooting Section 4.4)  

If the Sensor passes these tests, the green LED will blink at 1 Hz indicating that it’s working and waiting 

for communication with the PC and AquaScan HD™ PC Software. 

4.2 – LED Indicator 

The AquaScan HD™ Sensor is equipped with a green LED which was designed to give the user 

immediate information regarding the Sensor’s status.  When power is supplied to the Sensor and it is 

working properly, the LED will blink at 1 Hz indicating that the unit has powered up correctly and is 

waiting for communication with the PC and AquaScan HD™ software.  Once communication is 

established, the LED will stay on continuously.  However, if the unit is powered up and the green LED 

blinks at 4 Hz, then the unit is problematic and will not be able to communicate with the PC until the 

problem is rectified.  (See Troubleshooting Section 4.4) 

4.3 – Firmware Update 

The AquaScan HD™ Sensor is a self-contained unit and has its own set of Firmware.  Periodically, 

SyQwest may offer Sensor Firmware upgrades which add new features and functionality.  This section 

describes the process involved in updating that firmware. 
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4.3.1 – Connection 

 

The AquaScan HD™ Sensor Firmware does not need any special connection cables or connectors to 

perform an update.  The Sensor is connected to an available RJ-45 port a PC as if it were being used to 

acquire data.  (See Data Interface Connector in Section 2.2.4).   

4.3.2 – Firmware Update File 

If a Firmware Update file is available, SyQwest can send the user a disk containing the file, or it may be 

downloaded from our website (http://www.syqwestinc.com).  The file will always be called 

aquascanhd.hex.  This file should NOT be re-named because the AquaScan HD™ PC Software is 

configured to only detect its specific filename.  

This file should always be COPIED from the disk to the PC rather than being moved.  This allows the 

user to retain a copy of the file on disk for backup purposes.  Before copying the file, the AquaScan HD™ 

PC Software should NOT be running.  The file should be copied to the same directory as the AquaScan 

HD™ executable file.  (Usually C:\Program Files\SyQwest\AquaScanHD, unless 

otherwise specified). 

4.3.3 – AquaScan HD™ PC Software Firmware Update 

The AquaScan HD™ PC Software is designed to automatically detect the presence of a firmware update 

file upon startup.  If the file is detected, the user will be notified and asked whether the firmware update 

should take place.  If the user chooses “No”, then the AquaScan HD™ PC Software continues to run 

normally. 

 

NOTE: If the user chooses “No”, the firmware file will REMAIN in the AquaScan HD™ 

directory.  The file must be manually removed to avoid being detected each time 

the software is run. 

 

When the user clicks “Yes”, then the PC Software will attempt to communicate with the AquaScan HD™ 

Sensor while giving the user status message updates.  If there are no problems, the firmware upload will 

begin, and a progress indicator will be shown to the user.  Refer to Section 4.4 for troubleshooting 

information. 

NOTE: If the firmware update is successful, the firmware file WILL be removed from the 

AquaScan HD™ directory to prevent it from being detected again.  Make sure you 

have a backup copy of this file.  
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4.4 – Troubleshooting 

 

4.4.1 – AquaScan HD™ Sensor Troubleshooting 

 

Symptom Possible Cause Solution 

Green LED on Sensor does not 

turn on Sensor is not receiving power 

Check the power supply, inline 

fuse, and connections to the 

Sensor with a voltmeter 

Green LED on Sensor blinks 

rapidly at 4 Hz 

Power on Self Test 1, 2 or 3 has 

failed 

Contact SYQWEST Support 

Dept for assistance 

Green LED on Sensor blinks at 1 

Hz but cannot establish 

communication with PC software 

1) Connection problem between 

PC and Sensor 

2) PC Software not setup 

properly 

3) Flash Memory is corrupt 

1) Check connections between 

PC and Sensor 

2) Program the correct static IP 

address on the host computer 

3) Contact SYQWEST Support 

Dept for assistance 

 

4.4.2 – AquaScan HD™ PC Software Troubleshooting 

 

Symptom Possible Cause Solution 

Sensor State always shows 

Unknown 

PC Software not receiving 

communication from Sensor 

1) Check connections between 

PC and Sensor 

2) Make sure the Sensor’s LED 

is blinking at 1 Hz indicating 

that is ready for 

communicating 

3) Check the static IP address 

on the host computer 

Sensor State stuck in Power-up 

PC Software was executed after 

Sensor has already been 

initialized 

Cycle (remove then reapply) 

power to the AquaScan HD™ 

Sensor 

PC Software not receiving GPS 

information 

1) PC Software is not setup 

correctly 

2) There is a connection 

problem between the PC and 

GPS Receiver 

1) Correctly configure PC 

Software in the “NMEA I/O” 

menu to the correct COM 

port and to a compatible 

NMEA string with your GPS 

Receiver 

2) Check connections between 

PC and GPS Receiver 

PC Software is non-responsive or 

lagged 

Thermal Printing is enabled but 

no TDU is connected 

Check connection between PC 

and TDU or disable Thermal 

Printing in software 
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4.5 How to perform Software and Firmware Updates 

 

It is recommended you print these for reference while completing your firmware 

update.  

1  Uninstall the old versions of AquaScan HD™ software.  

2  Install the new version of AquaScan HD™ software provided to your PC.  

3  Connect the AquaScan HD™ power and data cable to the AquaScan HD™. Do not 

power it on.  

4  Using Windows Explorer go to the directory: 

C:\Program files\SyQwest\ AquaScan HD™ \Firmware\ 

 and copy the aquascanHD.hex file and place it into the “AquaScan HD™” directory.  

5  Then power on your AquaScan HD™, the software will then prompt you. New 

firmware detected do you wish to proceed with the update? Click the yes button and it will 

update the flash memory device on the DSP.  

6  When the update is completed cycle power on the AquaScan HD™ and you should 

see a flashing green light.  

7  Turn on the AquaScan HD™ software and click Help, About and it should show 

the following:  
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END OF MANUAL 


